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Disclaimer

Specifications written in this document are believed to be accurate, but are not guar-
anteed to be entirely free of error. The information in this manual is subject to
change for functional or performance improvements without notice. Please make sure
your manual is the latest edition. While the information herein is assumed to be
accurate, SEGGER Microcontroller GmbH & Co. KG (the manufacturer) assumes no
responsibility for any errors or omissions. The manufacturer makes and you receive
no warranties or conditions, express, implied, statutory or in any communication with
you. The manufacturer specifically disclaims any implied warranty of merchantability
or fitness for a particular purpose.

Copyright notice

You may not extract portions of this manual or modify the PDF file in any way without
the prior written permission of the manufacturer. The software described in this doc-
ument is furnished under a license and may only be used or copied in accordance
with the terms of such a license.

© 2011 SEGGER Microcontroller GmbH & Co. KG, Hilden / Germany
Trademarks
Names mentioned in this manual may be trademarks of their respective companies.

Brand and product names are trademarks or registered trademarks of their respec-
tive holders.

Contact address
SEGGER Microcontroller GmbH & Co. KG

In den Weiden 11
D-40721 Hilden

Germany

Tel.+49 2103-2878-0

Fax.+49 2103-2878-28

E-Mail: support@segger.com
Internet: http://www.segger.com
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Manual versions

This manual describes the latest software version. If any error occurs, please inform
us and we will try to assist you as soon as possible.

For further information on topics or routines not yet specified, please contact us.

SW version /
Manual revision

3.18/00 110330 AS a) New functions to change the font height added.

a) Merging of font files added.
b) SEGGER Logo replaced with the new one.

3.14/01 100813 AS a) Table of command line options reworked.

a) Extended antialiased formats added.
b) 'Pixel” and 'Point’ option added to font options dialog.

Date By Explanation

3.16/00 110106 AS

3.14/00 100104 JE c) Antialiasing options added.
d) New command line option ‘edit’ added.
3.10/03 090610 AS a) Redesigned manual.
3.10/02 081118 JE a) Company name changed.
3.10/01 071112 JE a) Font size explanation added.
3.10/00 070606 JE a) Framed fonts added.
3.08/00 060215 JE a) Logging of commands added.
3.06/00 060201 JE a) XBF format added.
3.04/00 051221 JE a) New font type added.
3.02/01 050408 JE a) Magnification options added.
a) Compatibility options added.
3.00/01 050117 JE b; Oper?ing ’C’¥i|e2 added.
2.18/01 030716 JE a) System independent fonts added.
2.16/02 030409 JE a) UConvert removed.
2.16/01 020812 JE a) Version number incremented.
2.14/02 020109 JE a) Chapter 2.4 changed to 3.
2.14/01 011213 JE a) 2bpp antialiasing mode added
a) Explanation of antialiasing modes added.
2.12/01 010402 IE b) Description of encoding modes inserted.

c) Shift JIS support of FontCvt explained.

d) UConvert: Shift JIS and command line interface.
2.10/01 010104 JE a) NT & 9x versions merged

a) Renamed: FontCvt -> FontConvert

b) Small changes

a) Complete revised

b) Version control table added

2.02/02 010103 JE

2.02/01 001213 JE

Software versions

Refers to Release.html for information about the changes of the software versions.
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About this document

Assumptions

This document assumes that you already have a solid knowledge of the following:

e The software tools used for building your application (assembler, linker, C com-
piler)
The C programming language
The target processor

¢ DOS command line.

If you feel that your knowledge of C is not sufficient, we recommend The C Program-
ming Language by Kernighan and Richie (ISBN 0-13-1103628), which describes the
standard in C-programming and, in newer editions, also covers the ANSI C standard.
How to use this manual

This manual explains all the functions and macros that FontConvert offers. It
assumes you have a working knowledge of the C language. Knowledge of assembly
programming is not required.

Typographic conventions for syntax

This manual uses the following typographic conventions:

Style Used for
Body Body text.
Keyword Text t_hat you entt_ar at the comm_and-pr_ompt or that appears on
the display (that is system functions, file- or pathnames).
Parameter Parameters in API functions.
Sample Sample code in program examples.

Sample comment | Comments in program examples.

Reference to chapters, sections, tables and figures or other docu-

Reference
ments.

GUIElement Buttons, dialog boxes, menu names, menu commands.

Emphasis Very important sections
Table 1.1:
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SEGGER Microcontroller GmbH & Co. KG develops

and distributes software development tools and ANSI

\ C software components (middleware) for embedded

} systems in several industries such as telecom, medi-

/ cal technology, consumer electronics, automotive
SEGG ER industry and industrial automation.

SEGGER’s intention is to cut software development

time for embedded applications by offering compact flexible and easy to use middleware,
allowing developers to concentrate on their application.

Our most popular products are emWin, a universal graphic software package for embed-
ded applications, and embQOS, a small yet efficient real-time kernel. emWin, written
entirely in ANSI C, can easily be used on any CPU and most any display. It is comple-
mented by the available PC tools: Bitmap Converter, Font Converter, Simulator and
Viewer. embOS supports most 8/16/32-bit CPUs. Its small memory footprint makes it
suitable for single-chip applications.

Apart from its main focus on software tools, SEGGER develops and produces programming
tools for flash microcontrollers, as well as J-Link, a JTAG emulator to assist in develop-
ment, debugging and production, which has rapidly become the industry standard for
debug access to ARM cores.

Corporate Office: United States Office:
http://www.segger.com http://www.segger-us.com
EMBEDDED SOFTWARE SEGGER TOOLS
(Middleware)
emWin Flasher
Graphics software and GUI Flash programmer
emWin is designed to provide an effi- Flash Programming tool primarily for microcon-
cient, processor- and display control- trollers.
ler-independent graphical user .
interface (GUI) for any application that J-Link
operates with a graphical display. JTAG emulator for ARM cores
Starterkits, eval- and trial-versions are USB driven JTAG interface for ARM cores.
available.
J-Trace
embOS JTAG emulator with trace
Real Time Operating System USB driven JTAG interface for ARM cores with
===  embOS is an RTOS designed to offer Trace memory. supporting the ARM ETM (Embed-
=] the benefits of a complete multitasking ded Trace Macrocell).
[ system for hard real time applications .
with minimal resources. The profiling J-Link / J-Trace Related Software
PC tool embOSView is included. Add-on software to be used with SEGGER’s indus-
try standard JTAG emulator, this includes flash
emfFile programming software and flash breakpoints.

File system
emFile is an embedded file system with

FAT12, FAT16 and FAT32 support.
FS emFile has been optimized for mini-

Table 1.1:

mum memory consumption in RAM and
ROM while maintaining high speed.
Various Device drivers, e.g. for NAND
and NOR flashes, SD/MMC and Com-
pactFlash cards, are available.

USB-Stack

USB device stack

A USB stack designed to work on any
embedded system with a USB client
controller. Bulk communication and
most standard device classes are sup-
ported.

g
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Chapter 1

Introduction
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10 CHAPTER 1 Introduction

Fonts which can be used with emWin should be defined either as GUI_FONT struc-
tures in C or should exist as system independent font data. If using C files the struc-
tures - or rather the font data which is referenced by these structures - can be rather
large. It is very time-consuming and inefficient to generate these fonts manually. We

therefore recommend using FontConvert, which automatically generates C files from
fonts.

The font converter is a Windows program which is easy to use. Simply load an
installed Windows font which is based on TrueType Outlines into the program, edit it
if you want or have to, and save it. The C file may then be compiled, allowing the font
to be shown on your display with emWin on demand.

The following is a sample screen shot of the font converter with a font loaded in nor-
mal (standard) mode:

;EﬁFont converter for emWin
Eile Edit Wew Options Help
DI i+ |7 x| -l |=|=] ==t 1] w|«| 2]z |4 7] TlL|T|1]
3050 sl iF |z o= ES L = EEN R R Hiragana .l
3060 = B -3 -3 ] T T |k L [ ¥ | A ) I Hiragana
3070 | [Es R | R S ~ < S E L E [ IE | A Hiragana —
3080 fr | & E X2 ] 1] k I i A kL ~ ) i Hiragana
3090 | A2 v ol | T u 5 Hiragana
30A0 7 T 1 A w T f S 7 Katakana
3080 a ' = = | +# +H | o7 %, = |+ |+ | v v A Katakana
30C0 E e E ERERE = |k S S = | = T | 7 2 Katakana
3000 Al A E = [ - v 7 - | L T B B < Katakana
30ED L A F | + -t T = | = 1] fl L ] 7 7 Katakana ¥
| | 3
Font Information
Font: M3 Mincho
Height: 1a
Max Width: 1a
Easeline: 14
:5 -: Character Information
Code: 12455 (0Ox3044)
Character: FKATAKANA LETTER ©
Width: 15
Di=shled: o
Height: 14
X-Po=ition: 1
T-Po=ition: 1
Cursor dist: 1a
I 11
|Ready v
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Chapter 2

Using the Font Converter

The font converter can create an emWin font file from an installed Windows font or it
can be used to edit the font data of a existing C font file.
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12 CHAPTER 2 Using the Font Converter

2.1 Creating an emWin font file from a Windows font

The basic procedure for using the font converter for creating an emWin font file from
an installed Windows font is illustrated below. The steps are explained in detail in the
sections that follow.

Step 1: Start the application.
The font converter is opened and
automatically displays the Font
generation options dialog box.
The same dialog box appears if S -
File/New is chosen from the font [ pmaniene || € e
converter menu at any point.

Font generaktion opktions E |

Twpe of font to generate

Step 2: Specify font generation
options. Antialiased. Zbpp
In this example, a font is to be gen- gniialiased, dbpp Cancel |
erated in extended mode and with Extended, framed
16-bit Unicode encoding. (The anti- Extended. antisliased, 2bpp

.. L .. Extended, antialiazed, 4bpp
aliasing option is irrelevant here
since an antialiased mode was not ~ Encading Antisliazsing
selected.) . :

; % 15 Bit UMICODE €% [lsing 05
Click OK. = -

2Bt ASCI + 150 2859 € [nternal
816 Bit SHIFT_JIS
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Step 3: Specify font options.

In this example, a regular-style, 16
pixel Arial font is chosen.

Click OK.

Font 7]
Font: Font style:
IAriaI IFleguIar 0K I
Al Black = |itdic Cancel |
() Arial Marrow Bald
T Avial Uricode MS Bold Italic . .
Batang Urit af Size
() Book dntiqua
) Bookman Old Style j
— Sample
AaBbYyZz

Thiz iz an OpenType font. Thiz same font will be used on bath wour

printer and your screen.

Fle Edt Uiew Options Help

QIR Al [Fla] Al (== 2= 18] w|«] 23] Al4] 7]

Choose File/Save As.

Select the desired format of the
font data file, C file, system inde-
pendent font or external bitmap
font.

Select a destination and a name for
the font file.

Click Save.

The font converter will create a
separate file in the specified desti-
nation, containing the currently
loaded font data.

o =
o020 | " # 5 % & ' ( )] + .
0030 1] 1 2 3 4 ] ] 7 g 9 <
oo & NG ¢ D E F G H ! J L
. 0050 P Q R S T u W W X A Iz \
Step 4: Edit the font as necessary. L — ER I N I N T T R b I
_ " " 0070 | p q v s 1 u v w * z { | =
See section "User Interface" for i ] il
more information on working with H Fontinformation.
the font converter user interface. NNNE EENN Bk Viien 38
H H Cpates formaton
1 ] o : Ein(;xgigﬁru. LETTER &
Trosiion: 0
I | G ot 8
| ] )
Ready VA
Step 5: Save the emWin font file. e BHE

Save I .;.3-_], My Computer

MRl B

@3% Floopy (A:)
\=Local Dsk (i)
@Compact Disc (D)

AnallB

File name:

Save az lype:
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14 CHAPTER 2 Using the Font Converter

2.2 Font generation options dialog
After starting the program

or when choosing the menu Font generation options |

point File/New, the follow-

ing dialog automatically Tuvpe of font to generate
occurs: -

iStandard Ok
The selections made here Antialiazed, Zbpp
will determine the output Antialiazed, 4bpp Cancel
mode of the generated font, E stended

how it is to be encoded, and
how it will be antialiased (if
an antialiased output mode

Extended, framed
Extended, antialiazed, 2bpp
Extended, antialiazed, 4bpp

is selected).
— Encoding — Antialiazing
* 1EBit UNICODE % [zing 05
i BBt ASCI +150 2259 £ |ntermal

" B/1EBit SHIFT_JIS

2.2.1 Type of font to generate
Standard

Creates a 1 bit per pixel font without antialiasing.
Antialiased, 2bpp

Creates an antialiased font using 2 bits per pixel.
Antialiased, 4bpp

Creates an antialiased font using 4 bits per pixel.
Extended

Creates a non antialiased 1 bit per pixel font with extended character information.
This type of font is required for applications which need support for compound char-
acters like used in Thai language.

Extended, framed

Creates a non antialiased 1 bit per pixel font with extended character information
with a surrounding frame. A framed font is always drawn in transparent mode
regardless of the current settings. The character pixels are drawn in the currently
selected foreground color and the frame is drawn in background color. For more
details please refer to the emWin user manual.

Extended, antialiased, 2bpp

Creates an antialiased 2 bit per pixel font with extended character information. Each
character has the same height and its own width. The pixel information is saved with
2bpp antialiasing information and covers only the areas of the glyph bitmaps.

Extended, antialiased, 4bpp

Creates an antialiased 4 bit per pixel font with extended character information. Each
character has the same height and its own width. The pixel information is saved with
4bpp antialiasing information and covers only the areas of the glyph bitmaps.
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2.2.2 Encoding
16 Bit UNICODE

With Unicode encoding, you have access to all characters of a font. Windows font
files contain a maximum of 65536 characters. All character codes of the C file are the
same as those in the Windows font file.

8 Bit ASCII + ISO 8859

This encoding mode includes the ASCII codes (0x20 - 0x7F) and the ISO 8859 char-
acters (0xAO - OxFF).

8/16 Bit SHIFT JIS

Shift JIS (Japanese Industry Standard) enables mapping from Unicode to Shift JIS in
accordance with the Unicode standard 2. For example, the Katakana letter “KU” is
shifted from its Unicode value of Ox30AF to the Shift JIS value of 0x834E, the Kanji
character 0x786F is shifted to 0x8CA5 and so on.

2.2.3 Antialiasing

You can choose between two ways of antialiasing. This choice only applies when an
antialiased font type has been selected.

Using OS

The operating system is used to do the antialiasing. The resulting characters appear
exactly the same as in any other windows application where antialiased characters
are displayed.

Internal

The internal antialiasing routines of the font converter are used to do the antialias-
ing. The resulting characters are more exact with regard to proportions.
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CHAPTER 2 Using the Font Converter

2.3 Font Dialog

After clicking OK in the Font generation options dialog box, a second dialog is dis-
played as follows:

fot _____________________________HH|

Font:; Faont ztyle: Size:
|MS Mincha |Rieqular [1d ak.

MS Sans Serif Cancel
T M5 Serf

MT Extra __i |Bold Italic , :
() Palating Linatype Urit of Size

Photoshop Large ' Piusls

Photozhiop Small j ~
Fointz

Scrpt:
Wiestern j

Thiz iz a TrueTwpe font. Thiz zame font will be uzed on both o
printer and pour screen,

This is where the font to be converted into a C file is selected. Be sure that you do
not violate any copyright laws by converting a font with the font converter.

2.3.1 Font, Font Style, and Size

These menus are used to select the particular font to be converted. The size of the
font is specified in pixels.

2.3.2 Script

The Script box is used to select the character set which should be mapped down from
Unicode into the first 256 characters in accordance with ISO 8859. It only applies
when using the 8 Bit ASCII + ISO 8859 encoding mode.

2.3.3 Unit of Size

This option button can be used to set '‘Points’ or ‘Pixels’ as measuring unit. Please
note that emWin does not know something about the unit 'Points’ whereas most of
other PC applications use the point size for specifying the font size. The font con-
verter uses the operating system for getting the desired font resource. Please note
that the font mapper of the operating system is not able to create each font in each
desired pixel height. In these cases the font mapper of the operating system creates
the nearest possible pixel height. This is not a bug of the font converter.
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2.4 User Interface

After clicking OK in the Font dialog box, the main user interface of the font converter
appears, loaded with the previously selected font. You may convert the font into a C
file immediately if you wish or edit its appearance first.

The font converter is divided into two areas. In the upper area, all font characters
appear scaled 1:1 as they will be displayed on your target device. Disabled charac-
ters are shown with a gray background. Per default all character codes which are not
included in the chosen font are disabled. For example, many fonts do not include
character codes from 0x00 to Ox1F and 0x7F to Ox9F, so these codes are grayed.

The current character is displayed in a magnified scale on the left side of the lower
area. Additional information about the font and the current character can be seen on
the right side. If you want to modify the character data, you must first activate the
lower area, either by pressing the <TAB> key or by simply clicking in the area.

2.4.1 Selecting the current character

Characters may be selected:

e by using the keys <up>, <DOWN>, <LEFT>, <RIGHT>, <PGUP>, <PGDOWN>,
<POS1l>, or <END>,

e by using the scroll bars; or

e by clicking a character with the left mouse button.

2.4.2 Toggling character status

Use the right mouse button to toggle the status of a specific

character or to enable/disable an entire row of characters. The Toggle characker

menu point Edit/Toggle activation as well as the <spaceE> key

will toggle the status of the current character. Disable row
Enable row

If you need to change the status of a

particular range of characters, choose |[IE[Xd@Elll] faEIETd e |
Edit/Enable range of characters or _

Edit/Disable range of characters from First Dhafacterl A0 0K

the menu. The range to be enabled or

disabled is then specified in a dialog I__astcharacterl FFFF Cancel

box using hexadecimal character val-
ues. To disable all characters, select
Edit/Disable all characters from the
menu.

2.4.3 Selecting pixels

When the lower area of the user interface is activated, you can move through the
pixels with the cursor, either by using the <up>, <DOWN>, <LEFT> and <RIGHT> keys
or by clicking on the pixels with the left mouse button.
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CHAPTER 2 Using the Font Converter

2.4.4 Modifying character bits

In the lower area you can use the <spaCE> key to invert the
currently selected bit. In antialiased mode, you can increase
and decrease the intensity of a pixel with the keys <+> and
<=>.

The status bar displays the intensity of the current pixel as
follows

Index of pixel[ 4,4 ]=2

2.4.5 Operations

The following size / shift / move operations are available:
Size operations

The size of a character (the font) may be modified by selecting Edit/Insert/Right,
Left, Top, Bottom or Edit/Delete/Right, Left, Top, Bottom from the menu, or by
using the toolbar:

Lll Add one pixel to the right.

IL' Add one pixel to the left.

El Add one pixel at the top

é| Add one pixel at the bottom
;ll Delete one pixel from the right.
I;l Delete one pixel from the left
:l Delete one pixel at the top

i| Delete one pixel at the bottom

Shift operations

Choose Edit/Shift/Right, Left, Up, Down from the menu to shift the bits of the cur-
rent character in the respective direction, or use the toolbar:

:l Shift all pixels right.
:l Shift all pixels left.
ll Shift all pixels up.
il Shift all pixels down.
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Move operations (extended font format only)

Choose Edit/Move/Right, Left, Up, Down from the menu to move the character
position in the respective direction, or use the toolbar:

i| Move image to the right.
i| Move image to the left.
il Move image up.

il Move image down.

Change cursor distance (extended font format only)

Choose Edit/Cursor distance/Increase, Decrease from the menu to move the
character position in the respective direction, or use the toolbar:

"ll Increase cursor distance.

"ll Decrease cursor distance.

Change font height (extended font format only)

Choose Edit/Font height/[Insert, Delete] [top, bottom] from the menu to add
or remove a row to or from the font, or use the toolbar:

il Insert a row at the top of the font

il Insert a row at the bottom of the font
ll Delete a row from the top of the font
Ll Delete a row from the bottom of the font

2.4.6 Modifying the viewing mode
The view mode may be changed by selecting the following options from the menu:
View/All Characters

If enabled (standard), all characters are shown. If disabled, only the rows with at
least one enabled character are shown.

El Toggles viewing mode.
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20 CHAPTER 2 Using the Font Converter

2.5 Options

Compatibility options

The font converter is able to create font files for all versions of emWin. Because there
have been a few small changes of the font format from the emWin version 3.50 to
the version 3.52, the C font files for these versions should be slightly different to
avoid compiler warnings or compiler errors.

Use the command Options/Compatibility to get into the following dialog:

Compatibility options

ermtin Wersion
& W3 B2y or later

£ W3 B08 or older Cancel |

After choosing the desired emWin version the OK button should be pressed.

Magnification options

The font converter is able to save the font data in a magnified format.
Use the command Options/Magnification to get into the following dialog:

Magnification factor E3

(8
L]

-
=
[EL

A magnification factor for the X and the Y axis can be specified here. If for example
the magnification factor for the Y axis is 2 and the height of the current font data is
18, the font height in the font file will be 36. The magnification in X works similar.
After saving the font in a magnified format a short message is shown to inform the
user, that the saved font is magnified:

Font converter for emWin E |

The Faont file has been saved with
the Following magnification Factors;

wil
iz

Logging

Logging of commands can be enabled or disabled using the command
Options/Logging:

0K

Cancel
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When logging is enabled the C files contain a history of the commands which has
been used to modify the font file.

Antialiasing

Antialiasing E3 |

— Internal antialiazing

0K

v Euppress optimization

Cancel

—Antialiazing uzing 05

[~ Enable gamma comrection for 442 and 444

When using ‘Internal antialiasing’ it is recommended to enable Suppress optimiza-
tion. This makes sure, that the horizontal and vertical alignment of the characters
fits to each other.

The option Enable gamma correction for AA2 and AA4 should be disabled. When
the option is enabled the antialiased pixels of the characters will appear a little more
darker.

2.6 Saving the font

The font converter can create C font files or system independent font data files. For
details about the SIF format please refer to the emWin documentation.

2.6.1 Creating a C file

When you are ready to generate a C file, simply select File/Save As from the font
converter menu, specify a destination and name for the file, choose the C file format
and click Save. A C file will automatically be created.

The default setting for the filename is built by the name of the source font and the
current height in pixels. For example, if the name of the source font is "Example" and
the pixel height is 10, the default filename would be Examplel0.c. If you keep this
default name when generating a C file, the resulting name of the font will be
GUI_FontExamplelO.c.

Please see Chapter 6 for examples of C files generated from fonts.

2.6.2 Creating a System Independent Font (SIF)

When you are ready to generate the file, simply select File/Save As from the font
converter menu, specify a destination and name for the file, choose the System
independent font format and click Save. A system independent font file will auto-
matically be created.

This file does not contain C structures which can be compiled with emWin but binary
font data, which can be used as described in the current emWin documentation.

2.6.3 Creating an External Binary Font (XBF)

When you are ready to generate the file, simply select File/Save As from the font
converter menu, specify a destination and name for the file, choose the External
binary font format and click Save. An external binary font file will automatically be
created.
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This file does not contain C structures which can be compiled with emWin but binary
font data, which can be used as described in the current emWin documentation.
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Modifying an existing C font file

23

The font converter is able to open existing font files and to modify their font data.
The tool can only open C font files generated by the font converter. If the C font files
have been modified manually, it can not be guaranteed, that they can be opened by

the font converter.

Step 2: Use the command
File\Load C file.

opened and click OK.

Select the desired C font file to be

" Font converter for emWin ¥3.10 =[ol=]
Olul] etle [Fle] A (=[] =[=[t[0] wlwl2[] Ald] 5]
Step 1: Start the application. Er———
The font converter is opened and REE
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eration options dialog box.
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7
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2.8 Merging fonts with existing C font files

The Font Converter is able to add the content of an existing C font file to the current
font data. Once a font is loaded via “File” -> “Load 'C’ file...” or created by “File” ->
“New” a C font file can be merged to it using “File” -> “Merge 'C’ file...". The Font
Converter requires the fonts to be of the same size, so the merging can be processed

properly.

Fle Edit Wiew Options Help
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0000 i‘
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0020 | " # ¥ % & . ( )l - + .
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0050 P Q R S T U W Wy s hd z L \
i i 0060 [ a b © d [ T [ h i ] K 1
Step 1: Load an existing font or cre-| o 01—+ '
ate a new one as described above. i —r— ¥ 5 : -
ooco A i A A A uA TE G E E E E \‘
. L oo o W6 16 |6 Jo Jo |n J8 U 0 _Ju u
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Font Information
Font:
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Height: 16
0X46) [ | Max Width: 35
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Character Information

Code: 65 (0x0041)
Character:
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The merged font file contains the
characters a-f (0x61 - 0x66).

Now the font can be edited and
saved as a new font file.
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Chapter 3

Pattern Files

If you need to create fonts with a special set of characters (often for displaying a
specific text), it can be very time consuming to enable every character by hand. In
these cases, pattern files can be used to enable your character codes.

A pattern file is nothing but a simple text file which contains the characters to be
included in the font file. It can be used by FontConvert to enable only the characters
you need.
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3.1 Creating pattern files using Notepad

One option for creating a pattern file is to use Notepad, which is part of the windows

accessories:

e Copy the text you want to display into the clipboard.

e Open Notepad.exe.

e Insert the contents of the clipboard into the Notepad document.

e Use Format/Font to choose a font which contains all characters of the text. You

can skip this step if you do not want to see the characters.
e Use File/Save As to save the pattern file. It is very important that you save the
file in text format:

Save as lupe: ITEHt Docurments [~ kxt] LI

Encoding: I Unicode LI

3.2 Creating pattern files using FontConvert

A pattern file may also be created directly in FontConvert. Select Edit/Save pattern
file from the menu to create a text file which includes all currently enabled charac-
ters.

3.3 Enabling characters using a pattern file

It is usually helpful to begin by disabling all characters. Select Edit/Disable all char-
acters from the menu if you need to do so.

Now choose Edit/Read pattern file. After opening the appropriate pattern file, all
characters included in the file are enabled. If the pattern file contains characters
which are not included in the currently loaded font, a message box will appear.
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Chapter 4

Supported output modes of fonts
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4.1

CHAPTER 4 Supported output modes of fonts

There are three modes supported by the Font Converter: standard, 2-bit antialiased
and 4-bit antialiased. If you are using a black and white LCD display, only the stan-
dard mode makes sense. If using a grayscale or color display, it is possible to
improve the appearance of a font through antialiasing.

Antialiasing smoothes curves and diagonal lines by blending the background color
with that of the foreground. The higher the number of shades used between back-
ground and foreground colors, the better the antialiasing result. The general purpose
of using antialiased fonts is to improve the appearance of text. While the effect of
using high-quality antialiasing will be more visually pleasing than low-quality, com-
putation time and memory consumption will increase proportionally. Low-quality
(2bpp) fonts require twice the memory of nonantialiased (1bpp) fonts; high-quality
(4bpp) fonts require four times the memory The following table shows the difference
between the modes by displaying the magnified character C in each:

Font Type Black On White White On Black

Standard
(no antialiasing)

1 bpp
2 shades

Low-quality
(antialiased)
2 bpp

4 shades

High-quality
(antialiased)
4 bpp

16 shades

Standard mode

When using this mode, a pixel can either be set or not. The memory requirement for
one pixel is one bit. If a pixel is set, it is displayed in the current foreground color.

4.2 Antialiased modes

These modes are recommended if you want to display characters with smoothed
edges. Every pixel is stored as a 2- or 4-bit value which describes the foreground
intensity. For example, when using 4-bit antialiasing, a value of 15 displays the pixel
in the current foreground color. An intensity of 10 means that the pixel color is a mix-
ture of 10 shares of foreground color and 5 shares of background color.

Before using one of these modes, the feature must be activated in your operating
system. Choose the effects sheet of the display properties dialog and activate smooth
edges of screen fonts.
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Chapter 5

Command line options
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CHAPTER 5 Command line options

5.1 Table of commands

The following table shows the available command line options:

Command

Description

create<FONTNAME>, <STYLE>,
<HEIGHT>, <TYPE>,
<ENCODING> [, <METHOD>]

Create font:
<FONTNAME> Name of the font to be used

<STYLE>
REGULAR - Creates a normal font
BOLD - Creates a bold font

<HEIGHT> Height in pixels of the font to be created
<TYPE>

STD - Standard 1 bpp font

AA2 - Antialiased font (2bpp)

AA4 - Antialiased font (4bpp)

EXT - Extended font

<ENCODING>

ucle - 16 bit Unicode encoding

IS08859 - 8 bit ASCII + IS08859

JIS - Shift JIS

<METHOD>

0s - Antialiasing of operating system (default)

INTERNAL - Internal antialiasing method

edit<ACTION>,
<DETATIL>[,<CNT>]

Equivalent to the 'Edit’ menu:
<ACTION>

DEL - Deletes pixels

INS - Inserts pixels

<DETAIL>

TOP - Delete/insert from top
BOTTOM - Delete/insert from bottom
<CNT>

Number of operations, default is 1

enable[FIRST-LAST>,

Enables or disables the given range of characters:
<FIRST-LAST> Hexadecimal values separated by a ‘-’
defining the range of characters

<STATE> <STATE>
1 - Enables the given range
0 - Disables the given range
oxit Exits the application after the job is done
Merges the given ’'C’ file to the current content.
merge<FILENAME>

readpattern<FILENAME>

Reads a pattern file:
<FILENAME> Name of the pattern file to be read

saveas<FILENAME>, <TYPE>

Saves the font data as ‘C’ file or ’'SIF’ font file:
<FILENAME> File name including extension

<TYPE>
C - Saves as 'C’ file
SIF - Saves as System independent font file

?

Shows all available commands

Table 5.1:

e All commands are processed from left to right.
e If using -exit Font Converter will stop execution if any error occurs. The return
code in this case is != 0.
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5.2 Examples

FontCvt -create"Cordia New",BOLD, 32,EXT,UCl6

Creates an extended bold font of 32 pixels height with Unicode encoding using the
font “Cordia New".

FontCvt FontFile.c -enableO-ffff,0 -readpattern"data.txt"

Reads the C font file “FontFile.c”, disables all characters and reads a pattern file.
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Chapter 6

Examples

These sections provide examples of C files generated by the font converter in stan-
dard, 2bpp antialiased and 4bpp antialiased modes, respectively.
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6.1 Resulting C code, standard mode

The following is an example of a C file in standard mode:

/*
C-file generated by Font converter for emWin version 3.04
Compiled: Dec 13 2005 at 12:51:50
C-file created: Dec 21 2005 at 12:42:57

Copyright (C) 1998-2005
Segger Microcontroller Systeme GmbH
www . Segger .com

Solutions for real time microcontroller applications

Source file: SamplelO.c
Font: Arial
Height: 10

*/

#include "GUI.H"
#ifndef GUI_CONST_STORAGE

#define GUI_CONST_STORAGE const
#endif

/* The following line needs to be included in any file selecting the
font. A good place would be GUIConf.H

*/

extern GUI_CONST_STORAGE GUI_FONT GUI_FontSamplelO;

/* Start of unicode area <Basic Latin> */

GUI_CONST_STORAGE unsigned char acFontSamplel0_0041[10] = { /* code 0041 */
X '
X_X ,
_ XX '
X_X ,
XX,
_XXXXX__,
X X,
X X,
Y
GUI_CONST_STORAGE unsigned char acFontSamplel0_0061[10] = { /* code 0061 */
_ XXX ,
X X ,
_XXXX ,
X X ,
X_ XX ,
_XX X ’
Y
GUI_CONST_STORAGE GUI_CHARINFO GUI_FontSamplelO_CharInfo[2] = {
{ 8, 8, 1, acFontSamplelO_0041 } /* code 0041 */
Rt 6, 6, 1, acFontSamplelO_0061 } /* code 0061 */

Yi

GUI_CONST_STORAGE GUI_FONT_PROP GUI_FontSamplelO_Prop2 = {

97 /* first character */
,97 /* last character */
,&GUI_FontSamplelO0_CharInfo[l] /* address of first character */

, (GUI_CONST_STORAGE GUI_FONT_PROP*)0 /* pointer to next GUI_FONT_PROP */
Y

GUI_CONST_STORAGE GUI_FONT_PROP GUI_FontSamplelO_Propl = {

65 /* first character */
, 65 /* last character */
,&GUI_FontSamplel0_CharInfo[0] /* address of first character */
,&GUI_FontSamplelO_Prop2 /* pointer to next GUI_FONT_PROP */

Y
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GUI_CONST_STORAGE GUI_FONT GUI_FontSamplel0 = {

GUI_FONTTYPE_PROP /* type of font */
,10 /* height of font */
,10 /* space of font y */
;1 /* magnification x */
1 /* magnification y */

, &GUI_FontSamplelO_Propl
}i

Resulting C code, 2 bpp antialiased mode

The following is an example of a C file in 2 bpp antialiased mode:

/*
C-file generated by Font converter for emWin version 3.04
Compiled: Dec 13 2005 at 12:51:50
C-file created: Dec 21 2005 at 12:42:57

Copyright (C) 1998-2005
Segger Microcontroller Systeme GmbH
www . Segger . com

Solutions for real time microcontroller applications
Source file: SamplelO.c
Font: Arial
Height: 14
*/
#include "GUI.H"
#ifndef GUI_CONST_ STORAGE
#define GUI_CONST_STORAGE const
#endif
/* The following line needs to be included in any file selecting the
font. A good place would be GUIConf.H
*/
extern GUI_CONST_STORAGE GUI_FONT GUI_FontSamplelO;

/* Start of unicode area <Basic Latin> */

35

GUI_CONST_STORAGE unsigned char acFontSamplel0_0041[ 28] = { /* code 0041 */
0x00, 0x00,
0x00, 0x00,
0x00, 0x00,
0x0B, 0xCO,
0x1F, 0xDO,
0x2E, OxEO,
0x3C, OxFO,
0x78, 0xB4,
0xBF, OxF8,
0xEO, 0x78,
0xE0, 0x3C,
0x00, 0x00,
0x00, 0x00,
0x00, 0x00

}i

GUI_CONST_STORAGE unsigned char acFontSamplelO_0061[ 28] = { /* code 0061 */
0x00, 0x00,
0x00, 0x00,
0x00, 0x00,
0x00, 0x00,
0x00, 0x00,
0x6F, 0x40,
0x93, 0xCO,
0x2B, 0xCO,
0xB7, 0xCO,
0xF7, 0xCO,
0x7B, 0xCO,
0x00, 0x00,
0x00, 0x00,
0x00, 0x00
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6.3
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GUI_CONST_STORAGE GUI_CHARINFO GUI_FontSamplelO_CharInfo[2] = {
{ 8, 8, 2, acFontSamplel0_0041 } /* code 0041 */
A 6, 6, 2, acFontSamplel0O_0061 } /* code 0061 */

GUI_CONST_STORAGE GUI_FONT_PROP GUI_FontSamplelO_Prop2 = {

0x0061 /* first character */

,0x0061 /* last character */

,&GUI_FontSamplelO_CharInfo[ 1] /* address of first character */

, (GUI_CONST_STORAGE GUI_FONT PROP*)0 /* pointer to next GUI_FONT_ PROP */
Y

GUI_CONST_STORAGE GUI_FONT_PROP GUI_FontSamplelO_Propl = {
0x0041 /* first character */
,0x0041 /* last character */
,&GUI_FontSamplelO_CharInfo[ 0] /* address of first character */
,&GUI_FontSamplel0_Prop2 /* pointer to next GUI_FONT_PROP */
Y

GUI_CONST_STORAGE GUI_FONT GUI_FontSamplel(l = {

GUI_FONTTYPE_PROP_AA2 /* type of font */
,14 /* height of font */
,14 /* space of font y */
,1 /* magnification x */
,1 /* magnification y */
,&GUI_FontSamplelO_Propl

Y

Resulting C code, 4 bpp antialiased mode

The following is an example of a C file in 4 bpp antialiased mode:

/*
C-file generated by Font converter for emWin version 3.04
Compiled: Dec 13 2005 at 12:51:50
C-file created: Dec 21 2005 at 12:42:57

Copyright (C) 1998-2005
Segger Microcontroller Systeme GmbH
www . Segger . com

Solutions for real time microcontroller applications

Source file: SamplelO.c
Font: Arial
Height: 10

*/

#include "GUI.H"

#ifndef GUI_CONST_STORAGE
#define GUI_CONST_STORAGE const
#endif

/* The following line needs to be included in any file selecting the
font. A good place would be GUIConf.H
*/

extern GUI_CONST_STORAGE GUI_FONT GUI_FontSamplelO;
/* Start of unicode area <Basic Latin> */

GUI_CONST_STORAGE unsigned char acFontSamplel0_0041[ 40] = { /* code 0041 */
0x00, 0x00, 0x00, 0x00,
0x00, OxCF, OxF2, 0x00,
0x03, OxFF, OxF6, 0x00,
0x09, OxFB, OxFB, 0x00,
0x0E, O0xE2, OxFE, 0x00,
0x5F, 0x90, OxCF, 0x40,
0xBF, OxFF, OxFF, 0x90,
0xFC, 0x00, Ox6F, 0xCO,
0xF8, 0x00, Ox2F, O0xF2,
0x00, 0x00, 0x00, 0x00

Examples
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GUI_CONST_STORAGE unsigned char acFontSamplelO_0061[ 30] = { /* code 0061 */
0x00, 0x00, 0x00,
0x00, 0x00, 0x00,
0x00, 0x00, 0x00,
0x3D, OxFE, 0x60,
0xD3, O0xO0F, OxEO,
0x29, O0xCF, OxFO,
0xDF, O0x4F, OxFO,
0xFF, O0x3F, OxFO,
0x6F, OxAF, OxFO,
0x00, 0x00, 0x00

}i

GUI_CONST_STORAGE GUI_CHARINFO GUI_FontSamplelO_CharInfo[2] = {
{ 8, 8, 4, acFontSamplel0_0041 } /* code 0041 */
PR 6, 6, 3, acFontSamplel0_0061 } /* code 0061 */

}i

GUI_CONST_STORAGE GUI_FONT_PROP GUI_FontSamplelO_Prop2 = {

0x0061 /* first character */

,0x0061 /* last character */

,&GUI_FontSamplelO_CharInfo[ 1] /* address of first character */

, (GUI_CONST_STORAGE GUI_FONT_PROP*)0 /* pointer to next GUI_FONT_PROP */
}i

GUI_CONST_ _STORAGE GUI_FONT_PROP GUI_FontSamplelO_Propl = {
0x0041 /* first character */
,0x0041 /* last character */
,&GUI_FontSamplel0_CharInfo[ 0] /* address of first character */
,&GUI_FontSamplelO_Prop2 /* pointer to next GUI_FONT_PROP */
}i

GUI_CONST_STORAGE GUI_FONT GUI_FontSamplell = {
GUI_FONTTYPE_PROP_AA4 /* type of font */
,10 /* height of font */
,10 /* space of font y */
,1 /* magnification x */
,1 /* magnification y */
,&GUI_FontSamplelO_Propl

}i

6.4 Resulting C code, extended mode

/*
C-file generated by Font converter for emWin version 3.04
Compiled: Dec 13 2005 at 12:51:50
C-file created: Dec 21 2005 at 12:45:52

Copyright (C) 1998-2005
Segger Microcontroller Systeme GmbH
www . Segger .com
Solutions for real time microcontroller applications
Source file: Ariall6.c
Font: Arial
Height: 16
*/
#include "GUI.H"
#ifndef GUI_CONST_STORAGE
#define GUI_CONST_STORAGE const
#endif
/* The following line needs to be included in any file selecting the
font. A good place would be GUIConf.H
*/
extern GUI_CONST_STORAGE GUI_FONT GUI_Fontl6;

/* Start of unicode area <Basic Latin> */
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GUI_CONST_STORAGE unsigned char acGUI_Fontl6_0041[ 20] { /* code 0041 */

bl
X

’

GUI_CONST_STORAGE unsigned char acGUI_Fontl6_0061[ 7]

{ /* code 0061 */

XXX,
X X ,
X ,
_XXXX ,
X X ,
X_ XX ,
XX X Y
GUI_CONST_STORAGE GUI_CHARINFO_EXT GUI_Fontl6_CharInfo[2] = {
{ 9, 10, 0, 3, 9, acGUI_Fontl6_0041 } /* code 0041 */
PRt 5, 7, 1, 6, 7, acGUI_Fontl6_0061 } /* code 0061 */

Y

GUI_CONST_STORAGE GUI_FONT_PROP_EXT GUI_Fontl6_Prop2 = {
0x0061 /* first character */
,0x0061 /* last character */
,&GUI_Fontl6_CharInfo[ 1] /* address of first character */
, (GUI_CONST_STORAGE GUI_FONT_PROP_EXT *)O0

Y

GUI_CONST_STORAGE GUI_FONT_PROP_EXT GUI_Fontl6_Propl = {
0x0041 /* first character */
,0x0041 /* last character */
,&GUI_Fontl6_CharInfo[ 0] /* address of first character */
,&GUI_Fontl6_Prop2 /* pointer to next GUI_FONT_PROP_EXT */
Y

GUI_CONST_STORAGE GUI_FONT GUI_Fontl6 = {
GUI_FONTTYPE_PROP_EXT /* type of font */
,16 /* height of font */

,16 /* space of font y */

,1 /* magnification x */

,1 /* magnification y */

, {&GUI_Fontl6_Propl}

,13 /* Baseline */

,7 /* Height of lowercase characters */

,10 /* Height of capital characters */
};

Examples
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